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SUMMARY: 15 

This protocol uses three-dimensional (3D) printers and laser cutters found in makerspaces in 16 

order to create a more flexible flight mill design. By using this technology, researchers can reduce 17 

costs, enhance design flexibility, and generate reproducible work when constructing their flight 18 

mills for tethered insect flight studies. 19 

 20 

ABSTRACT:  21 

Makerspaces have a high potential of enabling researchers to develop new techniques and to 22 

work with novel species in ecological research. This protocol demonstrates how to take 23 

advantage of the technology found in makerspaces in order to build a more versatile flight mill 24 

for a relatively low cost. Given that this study extracted its mill prototype from flight mills built in 25 

the last decade, this protocol focuses more on outlining divergences made from the simple, 26 

modern flight mill. Previous studies have already shown how advantageous flight mills are to 27 

measuring flight parameters such as speed, distance, or periodicity. Such mills have allowed 28 

researchers to associate these parameters with morphological, physiological, or genetic factors. 29 

In addition to these advantages, this study discusses the benefits of using the technology in 30 

makerspaces, like 3D printers and laser cutters, in order to build a more flexible, sturdy, and 31 

collapsible flight mill design. Most notably, the 3D printed components of this design allow the 32 

user to adjust the heights of the mill arm and infrared (IR) sensors to test insects of various sizes. 33 

The 3D prints also enable the user to easily disassemble the machine for quick storage or 34 

transportation to the field. Moreover, this study makes greater use of magnets and magnetic 35 

paint to attach insects to the machine with minimal stress. Lastly, this protocol details a versatile 36 

analysis of flight data through computer scripts that efficiently separate and analyze 37 

differentiable flight trials within a single recording. Although more labor-intensive, applying the 38 

tools available in makerspaces and on free, online 3D modeling programs can help researchers 39 

avoid costly, premade products with narrowly adjustable dimensions and can facilitate 40 

multidisciplinary and process-orientated practices. By taking advantage of the flexibility and 41 

reproducibility of technology in makerspaces, this protocol promotes creative flight mill design 42 

and inspires open science. 43 

 44 
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INTRODUCTION:  45 

Given how intractable the dispersal of insects is in the field, the flight mill has become a common 46 

laboratory tool to address an important ecological phenomenon – how insects move. As a 47 

consequence, since the pioneers of the flight mill1-4 ushered in six decades of flight mill design 48 

and construction, there have been noticeable design shifts as technologies improved and became 49 

more integrated into scientific communities. Over time, automated data-collecting software 50 

replaced chart recorders, and flight mill arms transitioned from glass rods to carbon rods and 51 

steel tubing5. In the last decade alone, magnetic bearings replaced Teflon or glass bearings as 52 

optimally frictionless, and pairs between flight mill machinery and versatile technology have been 53 

proliferating as audio, visual, and layer fabrication technology become increasingly integrated 54 

into researchers’ workflows. These pairings have included high-speed video cameras to measure 55 

wing aerodynamics6, digital-to-analog boards to mimic sensory cues for studying auditory flight 56 

responses7, and 3D printing to make a calibration rig to track wing deformation during flight8. 57 

With the recent rise of emerging technologies at makerspaces, particularly at institutions with 58 

digital media centers run by knowledgeable staff9, there are greater possibilities to enhance the 59 

flight mill to test a larger range of insects and to transport the device to the field. There is also a 60 

high potential for researchers to cross disciplinary boundaries and accelerate technical learning 61 

through production-based work9–12. The flight mill presented here (adapted from Attisano and 62 

colleagues13) takes advantage of emerging technologies found in makerspaces to not only 1) 63 

create flight mill components whose scales and dimensions are fine-tuned to the project at hand 64 

but also 2) offer researchers an accessible protocol in laser cutting and 3D printing without 65 

demanding a high-budget or any specialized knowledge in computer-aided design (CAD) models. 66 

 67 

The benefits of coupling new technologies and methods with the flight mill are substantial, but 68 

flight mills are also valuable stand-alone machines. Flight mills measure insect flight performance 69 

and are used to determine how flight speed, distance, or periodicity relates to environmental or 70 

ecological factors, such as temperature, relative humidity, season, host plant, body mass, 71 

morphological traits, age, and reproductive activity. Distinct from alternative methods like 72 

actographs, treadmills, and the video recording of flight movement in wind tunnels and indoor 73 

arenas14, the flight mill is notable for its ability to collect various flight performance statistics 74 

under laboratory conditions. This helps ecologists address important questions on flight 75 

dispersal, and it helps them progress in their discipline – whether that be integrated pest 76 

management15–17, population dynamics, genetics, biogeography, life-history strategies18, or 77 

phenotypic plasticity19–22. On the other hand, devices like high-speed cameras and actographs 78 

can require a strict, complicated, and expensive setup, but they can also lead to more fine-tuned 79 

movement parameters, such as wing-beat frequencies and insect photophase activity23,24. Thus, 80 

the flight mill presented here serves as a flexible, affordable, and customizable option for 81 

researchers to investigate flight behavior. 82 

 83 

Likewise, the incentive to integrate emerging technologies into ecologists’ workflow continues 84 

to rise as questions and approaches to studying dispersal become more creative and complex. As 85 

locations that promote innovation, makerspaces draw in multiple levels of expertise and offer a 86 

low learning curve for users of any age to acquire new technical skills10,12. The iterative and 87 

collaborative nature of prototyping scientific devices in the makerspace and through online open 88 



   

sources can accelerate the application of theory11 and facilitate product development in the 89 

ecological sciences. Furthermore, increasing the reproducibility of scientific tools will encourage 90 

wider data collection and open science. This can help researchers standardize equipment or 91 

methods for measuring dispersal. It can allow researchers to unify dispersal data across 92 

populations in order to test metapopulation models that develop from dispersal kernels25 or 93 

source-sink colonization dynamics26. Much like how the medical community is adopting 3D 94 

printing for patient care and anatomy education27, using laser cutters and 3D printers can 95 

redesign ecological tools and education and, within the scope of this study, can be used to design 96 

additional flight mill components, such as landing platforms or a flight mill arm that can move 97 

vertically. In turn, the customization, cost-effectiveness, and increased productivity offered by 98 

makerspace technology can help start up dispersal projects with a relatively low barrier for 99 

researchers who intend to develop their own tools and devices. 100 

 101 

To construct this flight mill, there are also mechanical and instrumental limitations that can be 102 

considered by the maker. Magnets and 3D printed enhancements allow the flight mill to be 103 

essentially glueless, except for the construction of the cross brackets, and to be accommodable 104 

to insects of different sizes. However, as the mass and the strength of insects increase, insects 105 

may be more likely to dismount themselves while tethered. Strong magnets can be used at the 106 

cost of increased torsional drag, or ball bearings can replace magnetic bearings as a robust 107 

solution for flight testing insects that weigh several grams28,29. Nevertheless, ball bearings can 108 

also present some problems, mainly that running experiments with high speeds and high 109 

temperatures for long trial times can degrade the lubrication of ball bearings, which increases 110 

friction30. Thus, users will have to discern which flight mill mechanics would best suit their 111 

insect(s) of study and experimental design.  112 

 113 

Similarly, there are several ways to instrument a flight mill that is beyond this paper’s 114 

considerations. The flight mill presented in this paper uses IR sensors to detect revolutions, 115 

WinDAQ software to record revolutions, and programming scripts to process the raw data. 116 

Although it is easy-to-use, the WinDAQ software has a limited array of tools available - users 117 

cannot attach comments to their corresponding channel, and they cannot be alerted if any 118 

component of the circuitry fails. These cases are solved by detecting and correcting them through 119 

code but only after data collection. Alternatively, users can adopt more than one software that 120 

offers customizable data collection features28 or sensors that take direct speed and distance 121 

statistics, like bike milometers29. However, these alternatives can bypass valuable raw data or 122 

diffuse functionality across too many software applications, which can make data processing 123 

inefficient. Ultimately, rather than refashioning flight mill instrumentation, this protocol offers 124 

robust programming solutions to present-day software limitations.  125 

 126 

In this paper, a design for an enhanced simple flight mill is described to aid researchers in their 127 

dispersal studies and to encourage the incorporation of emerging technologies in the field of 128 

behavioral ecology. This flight mill fits within the constraints of an incubator, holds up to eight 129 

insects simultaneously, and automates data collection and processing. Notably, its 3D printed 130 

enhancements allow the user to adjust the mill arm and IR sensor heights to test insects of 131 

various sizes and to disassemble the device for quick storage or transportation. Thanks to 132 



   

institutional access to a communal makerspace, all enhancements were free, and no additional 133 

costs were accrued compared to the simple, modern flight mill. All software needed are free, the 134 

electronic circuitry is simple, and all scripts can be modified to follow the specific needs of the 135 

experimental design. Moreover, coded diagnostics allow the user to check the integrity and 136 

precision of their recordings. Lastly, this protocol minimizes the stress sustained by an insect by 137 

magnetically painting and attaching insects to the mill arm. With the assembly of the simple flight 138 

mill being already accessible, affordable, and flexible, the use of makerspace technologies to 139 

enhance the simple flight mill can grant researchers the space to overcome their own specific 140 

flight study needs and can inspire creative flight mill designs beyond this paper’s considerations. 141 

 142 

PROTOCOL: 143 

 144 

1. Build the flight mill in a makerspace 145 

 146 

1.1 . Laser cut and assemble the acrylic plastic support structure.  147 

 148 

1.1.1. Use 8 (304.8 mm x 609.6 mm x 3.175 mm) thick transparent acrylic sheets to construct 149 

the acrylic plastic support structure. Ensure that the material is not polycarbonate, which looks 150 

similar to acrylic but will melt instead of getting cut under the laser. 151 

 152 

1.1.2. Locate the laser cutter in the makerspace. This protocol assumes the makerspace has a 153 

laser cutter, as referenced in the Table of Materials. For other laser cutters, read the laser cutter 154 

settings to determine what line color or thickness is needed to set the file lines to be laser cut or 155 

engraved (not to be rastered).  156 

 157 

1.1.3. Open Adobe Illustrator, Inkscape (free), or another vector graphics editor. Prepare a file 158 

that reads the acrylic support design in a vector format with the aforementioned lines shown in 159 

Figure 1. Create file lines in Adobe Illustrator in Red, Green, and Blue (RGB) mode with a line 160 

stroke of 0.0001 point where RGB Red (255, 0, 0) cuts lines and RGB Blue (0, 0, 255) etches lines.  161 

 162 

1.1.4. As a precaution, test and account for kerf for all slit and hole measurements. Design and 163 

test the kerf key (Supplemental Figure 1). 164 

 165 

NOTE: The measurements can vary based on the beam width of the laser cutter, the width of the 166 

material, and the material type used.  167 

 168 

1.1.5. To allow the software to read, save the acrylic support designs and kerf key as file types 169 

such as .ai, .dxf, or .svg files. To send the job to the laser cutter, print the file on the laser cutter’s 170 

local machine and then open the laser software. 171 

 172 

NOTE: If printed correctly, all the vector cutting lines in the design will appear with the 173 

appropriate corresponding colors in the laser software’s control panel.  174 

 175 



   

1.1.6. Select the material as Plastic and then the material type as Acrylic. For extra precision, 176 

measure the material thickness with a caliper and enter its thickness into the material thickness 177 

field. Auto-enable the Z-axis of the material’s focal point. Set the Figure Type to None and leave 178 

the Intensity at 0%. To change any advanced metrics on the laser cutter, such as the laser % 179 

Power or % Speed, test with the kerf key. 180 

 181 

NOTE: The rule of thumb is that the thicker the material, then the more power is required at a 182 

lower speed. 183 

 184 

1.1.7. Before cutting, follow the makerspace’s guidelines on powering up, using, and 185 

maintaining the laser cutter. Place the materials in the printer cavity and cut the acrylic supports. 186 

 187 

NOTE: To prevent possible eye damage, do not look at the laser or leave any acrylic sheet 188 

unattended while cutting. 189 

 190 

1.1.8. Clean excess material out of the printer cavity and assemble the support structure. 191 

Assemble by inserting each horizonal shelf into the open slits of the outside vertical walls and 192 

central vertical wall as labeled in Figure 2A. Ensure that the holes between the horizontal shelves 193 

are aligned.  194 

  195 

1.2. 3D print the plastic supports 196 

 197 

1.2.1. Open a web browser and create a free account on an online 3D modeling program.  198 

 199 

1.2.2. Click on 3D Designs > Create a new design. To replicate this study’s exact 3D printed 200 

designs as seen in Figure 3, download the archive 3D_Prints.zip (Supplemental 3D Prints), and 201 

move the folder onto the desktop. Unzip and open the folder. In the online 3D modeling program 202 

workplane webpage, click on Import in the top right corner and select the .stl file(s). 203 

 204 

NOTE: Multiple design replicates or objects can fill the workplane and be saved as a single .stl file 205 

as long as the user restrains the objects within the boundaries of the build area of the 3D printer. 206 

The largest object a 3D printer can print is 140 mm length x 140 mm width x 140 mm depth. 207 

However, do not rotate the objects along their z-axis as a means to maximize the number of 208 

objects on a build area. That is because the downloaded objects have been positioned to 209 

minimize overhangs, and so they can be printed optimally with the minimal necessary supports.  210 

 211 

1.2.3. To self-create or make adjustments to the designs, follow the website’s tutorials, make 212 

edits, and then export the new designs as .stl files. In total, 8 linear guide rails (100.05 mm length 213 

x 23.50 mm width x 7.00 mm depth), 16 linear guide rail blocks (22.08 mm length x 11.47 mm 214 

width x 12.47 mm depth), 12 to 20 screws (9.00 mm length x 7.60 mm width x 13.00 mm depth), 215 

15 cross brackets (50.00 mm length x 50.00 mm width x 20.00 mm depth), 16 magnet holders 216 

(12.75 mm length x 12.50 mm width x 15.75 mm depth), 16 tube supports (29.22 mm length x 217 

29.19 mm width x 11.00 mm depth), 16 short linear guide rail supports (40.00 mm length x 11.00 218 

mm width x 13.00 mm depth), and 16 long linear guide rail supports (40.00 mm length x 16.00 219 



   

mm width x 13.00 mm depth) need to be 3D printed. To obtain the mirror of each linear guide 220 

rail design, click on the object, press M, and select the arrow corresponding to the object’s width. 221 

 222 

NOTE: See step 1.3.6. for more information on the linear guide rail pegs. 223 

 224 

1.2.4. Download and install a 3D printing slicing software to convert .stl files to a 3D printer 225 

readable .gx file. Refer the Table of Materials to download the free software program. 226 

 227 

NOTE: Other conversion software programs are acceptable, but this protocol assumes the 228 

makerspace is using the 3D printer and printing slicing software as referenced in the Table of 229 

Materials. 230 

 231 

1.2.5. Double-click the icon of the 3D printing slicing software to start the software. Click Print 232 

> Machine Type and select the 3D printer that is located in the makerspace. 233 

 234 

1.2.6. Click the Load icon to load a .stl model file and display the object on the build area. 235 

 236 

1.2.7. Select the object and double-click the Move icon. Click On Platform to ensure that the 237 

model is on the platform. Click Center to place the object at the center of the build area or drag 238 

the object with the mouse pointer to position the object on the build area. 239 

 240 

1.2.8. Click on the Print icon. Ensure that Material Type is set to PLA, supports and raft are 241 

enabled, Resolution is set to Standard, and the temperature of the extruder matches the 242 

temperature suggested by the 3D printer guide. The temperature can be changed within More 243 

Options >> Temperature. 244 

 245 

1.2.9. Press OK and save the .gx file in the 3D_Prints folder or on a USB stick if the file cannot 246 

be transferred to the 3D printer through a USB cable. 247 

 248 

1.2.10. Locate a makerspace’s 3D printing machine. Calibrate the extruder and ensure that there 249 

is enough filament for printing. Transfer the .gx file to the 3D printer and print all types and 250 

quantities of plastic supports and enhancements. For each print, check that the filament is 251 

sticking properly to the plate. 252 

 253 

1.3. Assemble 3D prints onto the acrylic support structure. 254 

 255 

1.3.1. To visualize all the supports in place, see Figure 2B.  256 

 257 

1.3.2. Hot glue the 3.175 mm thick neoprene sheets onto the interior walls of the cross bracket. 258 

When dry, insert the cross brackets at the junctions of the acrylic shelves and the walls at the 259 

back of the device to stabilize the flight mill. 260 

 261 



   

1.3.3. Wherever possible, use 3D printed screws in order to minimize the magnetic influence of 262 

iron screws. Screw in the tube supports onto the bottom and the top of each cell. Ensure that the 263 

top and bottom tube supports are aligned. 264 

 265 

1.3.4. Insert a 30 mm long plastic tube (inner diameter (ID) 9.525 mm; outer diameter (OD) 12.7 266 

mm) into the top tube support and a 15 mm long plastic tube (ID 9.525 mm; OD 12.7 mm) into 267 

the bottom tube support of each cell. Then, insert a 40 mm long plastic tube (ID 6.35 mm; OD 268 

9.525 mm) into the top tube and a 20 mm long plastic tube (ID 6.35 mm; OD 9.525 mm) into the 269 

bottom tube. Ensure that there is strong enough friction between the tubes to hold the tubes in 270 

place, but not too much that the inner tube can still slide up and down if pulled on. If tubes are 271 

warped, submerge segments of the tubes for 1 min in boiling water. Straighten the tubes out on 272 

a towel, allow it to reach room temperature and then insert the tubes.  273 

 274 

1.3.5. Place the two low-friction neodymium magnets (10 mm diameter; 4 mm length; 2.22 kg 275 

holding force) and an inner tube into each magnet support. Check if each pair of magnets is 276 

repelling each other. Additionally, lodge the inner tube firmly lodged into each magnet support 277 

so that gravity acting on the magnets and the magnet support is not strong enough to dislodge 278 

them from the inner tube. 279 

 280 

1.3.6. Facing the same direction, slide two linear guide rail blocks into the linear guide rail. Lodge 281 

the linear guide rails and blocks upright into the windows on the outer vertical walls. Ensure that 282 

the block openings are facing upwards. To secure one linear guide rail in place, use two short 283 

linear guide rail supports, two long linear guide rail supports, four 10 mm long iron screws (M5; 284 

0.8 thread pitch; 5 mm diameter), two 20 mm long iron screws (M5; 0.8 thread pitch; 5 mm 285 

diameter), and two hex nuts (M5; 0.8 thread pitch; 5 mm diameter). Figure 2C shows the full 286 

assembly of linear guide rail.  287 

 288 

NOTE: Open slots in the linear guide rail are intended to be used if and only if the linear guide rail 289 

becomes eroded by the repeated sliding of its block. If so, 3D print a small T-shaped peg found in 290 

the 3D_Prints folder. 291 

 292 

1.4. Construct the pivoting arm.  293 

 294 

NOTE: Sub-sections 1.4.1 and 1.4.2 are equivalent to sub-sections 1.2.2. and 1.2.3. in Attisano et 295 

al. 2015 methods paper13.  296 

 297 

1.4.1. Puncture the filter of a 20 μL filtered pipette tip at its center point using an entomological 298 

pin. Then, push the pin through the pipette tip until the steel ends of the pin protrude from the 299 

body of the pipette tip. Ensure that the filter of the pipette tip secures the pin in place. The pin 300 

serves as the axis of the flight mill arm. 301 

 302 

1.4.2. To maximize cell space, cut a 19 G non-magnetic hypodermic steel to a length of 24 cm (1 303 

cm less than the width of a flight cell). Hot glue the protruding pin and the crown of the pipette 304 



   

tip from step 1.4.1. to the midpoint of the tubing. Bend one end of the tubing at 2 cm from the 305 

end to an angle of 95. 306 

 307 

NOTE: To prioritize insect size rather than maximize cell space, shorten the radius of the arm for 308 

smaller insects or weak flyers. A longer flight arm can also be assembled if the center acrylic wall 309 

is removed for larger insects or strong flyers. Moreover, the bent ending of the arm can support 310 

different angles in order to position the insect in its natural flight orientation. 311 

 312 

1.4.3. To test its magnetic suspension, position the arm between the top set of magnets. Ensure 313 

that the rotating arm spins freely around the vertically suspended pin. 314 

 315 

1.4.4. Glue the two low-friction neodymium magnets (3.05 mm diameter; 1.58 mm length; 0.23 316 

kg holding force) on the bent end of the pivot arm to tether the metal-painted insect for flight 317 

(mass of flight mill arm with magnets = 1.4 g). On the unbent end of the pivot arm, wrap a piece 318 

of aluminum foil (mass per area = 0.01 g/cm2) to create a flag. The foil flag acts as a 319 

counterweight, and, due to its highly reflective properties, it optimally breaks the IR beam sent 320 

from the IR sensor transmitter to the receiver. 321 

 322 

NOTE: The diameter of the IR beam is at most 2.4 mm, so the optimal minimum width of the foil 323 

flag is 3 mm. A foil flag width of 3 mm and positioned to break the beam of IR light in front of the 324 

sensor’s emitter lens will produce a drop in voltage that is detectable during analyses. 325 

 326 

1.5. Set up the IR sensor and data logger. 327 

 328 

1.5.1. Place the IR sensor transmitter inside the top linear guide rail block with the emitter of 329 

the beam facing downwards. Then, place the IR sensor receiver inside the bottom block facing 330 

upwards.  331 

 332 

NOTE: The sensors (20 mm length x 10 mm width x 8 mm depth) can be separated up to a distance 333 

of 250 mm and still function; therefore, they will function even when positioned at the ends of 334 

the approximately 100 mm linear guide rail. 335 

 336 

1.5.2. On a solderless breadboard, connect the IR sensor transmitter and receiver in series with 337 

the 4-channel analog input data logger, as shown in the electronic circuit in Figure 4A. Connect 338 

the IR sensor transmitter (not the receiver) input first, following the 180 Ω resistor. Place another 339 

2.2 kΩ resistor before the output of the IR receiver connection. Configure each channel’s 340 

electronic circuit in alternate rows along the breadboard to minimize noise in the voltage signal 341 

from multiple sensors during recording (Figure 4B). 342 

 343 

2. Conduct Flight Trials 344 

 345 

2.1. Magnetically tether insects to the flight mill arm. 346 

 347 



   

2.1.1. To minimize stress placed on the insect, apply magnetic paint on the insect’s pronotum 348 

using either a toothpick or a fineline precision applicator (20 G tip). Let the paint dry for at least 349 

10 min. Once dry, attach the insect to the flight mill arm magnets. Refer Figure 5 to see examples 350 

of magnetic application and tethering for insects of different sizes. This protocol uses Jadera 351 

haematoloma (soapberry bug) as the model insect for flight tethering and trial experimentation. 352 

 353 

NOTE: For a stronger attraction between the insect and the arm magnets, apply multiple layers 354 

of magnetic paint. Additionally, swap out the magnets attached to the end of the flight mill arm 355 

for magnet sizes that best accommodate the insects’ field of vision, mass, and wing range. 356 

 357 

2.1.2. Flow up to 8 insects at a time in the flight mill. Paint prep at least 16 insects in order to 358 

test multiple insects sequentially during a single recording session. 359 

 360 

2.1.3. To remove the magnetic paint after testing, chip off the paint with fine forceps and 361 

dispose of it according to Environmental Protection Agency (EPA) and Occupational Safety and 362 

Health Administration (OSHA) regulations. 363 

 364 

2.2. Record multiple insects sequentially without terminating a recording session using 365 

WinDAQ’s Event Marker Comment tool.  366 

 367 

2.2.1. Download and install the free WinDAQ Data Recording and Playback Software. 368 

 369 

2.2.2. Create a new folder titled Flight_scripts on the desktop. Create five new folders with the 370 

following exact names inside the Flight_scripts folder: data, files2split, recordings, split_files, 371 

and standardized_files. Download the datasheet.xlsx (Supplemental File 1) and drag the file into 372 

the data folder in the Flight_scripts directory. 373 

 374 

2.2.3. Use the datasheet.xlsx as a manual data-recording template. A minimum of four columns 375 

is needed: the identification number of the bug, whether the bug died before being tested, the 376 

recording set number, and the chamber comprised of the channel letter and channel number 377 

(e.g., ‘A-1’, ‘B-4’). Refer Figure 2A for one possible chamber configuration.  378 

 379 

2.2.4. Open the WinDAQ Dashboard, select the data-logger(s) from the checkbox list, and press 380 

‘Start Windaq Software’. A new window will open for each data-logger selected, and the input 381 

signal from each sensor will be shown. 382 

 383 

2.2.5. To start a new recording session, press File > Record. Select the location of the recording 384 

file in the first pop-up window. Write the file name carefully. Files have to have at least the 385 

following in their names: the recording set number and channel letter. An example of a filename 386 

modeled in the Python scripts is the following: T1_set006-2-24-2020-B.txt. Refer to split_files.py 387 

lines 78-87 from the Flight_scripts folder to get further details. Then, press OK. 388 

 389 



   

2.2.6. In the next pop-up window, enter the anticipated length of the flight recording. Press OK 390 

when the insects are in a position to begin flight. After the recording time, press Ctrl-S to finalize 391 

the file. Do not press Ctrl-S unless there is a need to terminate the recording early.  392 

 393 

NOTE: If the file terminates too early either by typing Ctrl+S or the aforementioned length of time 394 

was too short, append a new recording to an existing file by clicking on File > Record. Select the 395 

file to append to and click Yes on the following pop-up window. 396 

 397 

2.2.7. When pulling out tested insects during the recording, insert a commented event marker 398 

of the incoming insect at its selected chamber. Always manually record the ID, chamber, and 399 

recording set of the incoming insect in datasheet.xlsx before swapping insects. 400 

 401 

2.2.8. To make an event marker comment, click on the channel number. Then, click Edit > Insert 402 

Commented Mark. Define the comment with the identification number of the new insect 403 

entering the chamber. Press OK and load the insect into the chamber.  404 

 405 

2.3. Visualize event marker comments and convert file from WDH to TXT. 406 

 407 

2.3.1. Visualize event marker comments by going to Edit > Compression… and then click the 408 

Maximum button to fully compress the waveform into one window (Figure 6A). 409 

 410 

2.3.2. Check for any abnormalities in the recording.  411 

 412 

NOTE: The types of abnormalities or failures in the recording are displayed in Figure 6. These are 413 

diagnosed later and corrected in the Python scripts. 414 

 415 

2.3.3. Save the file in a .txt format by going to File > Save As. Select the recordings folder inside 416 

the Flight_scripts directory as the location to save the file. Select the file type as Spreadsheet 417 

print (CSV) in the pop-up window and write the filename with .txt at the end. Click Save. In the 418 

following pop-up window, select Sample Rate, Relative Time, and Date and Time. Type 1 in 419 

between Channel Number and Event Markers. Deselect all other options and click OK to save 420 

the file. 421 

 422 

3. Analyze Flight Data  423 

 424 

3.1. Split files by event marker comments. 425 

 426 

3.1.1. Install the latest version of Python. All scripts in this protocol were developed on Python 427 

version 3.8.0.  428 

 429 

3.1.2. Download the following Python scripts: split_files.py, standardize_troughs.py, and 430 

flight_analysis.py (Supplemental Coding Files). Move the scripts into the Flight_scripts folder. 431 

 432 



   

3.1.3. Ensure that Python is up to date and install the following libraries: csv, os, sys, re, 433 

datetime, time, numpy, math, and matplotlib.pyplot. To observe the main functions and data 434 

structures of the scripts, see the schematic in Supplemental Figure 2. 435 

 436 

3.1.4. Open the datasheet.xlsx file and save as a CSV by changing the file format to CSV UTF-8 437 

(Comma delimited) if running Windows or Macintosh Comma Separated if running Mac.  438 

 439 

3.1.5. Open the split_files.py icon with the text editor of choice. If there is no preference, right-440 

click on the script icon and select Open with IDLE.  441 

 442 

3.1.6. Recode lines 133-135 and 232-233 if the user wrote a filename different from the 443 

suggested template (‘T1_set006-2-24-2020-B.txt’). To record the script to accommodate 444 

different filenames using the split() function see lines 116-131.  445 

 446 

3.1.7. In line 266, type the path to the Flight_scripts folder, and run the script. After a successful 447 

run, the script generates intermediate .txt files of mapped insect IDs in the files2split folder and 448 

.txt files for each insect tested in each recording set in the split_files folder, within the 449 

Flight_scripts directory. 450 

 451 

NOTE: Additionally, in the Python Shell, users should see print statements of the filename, which 452 

insects are being swapped at a numbered event marker, and which files are being split and 453 

generated into new files by insect ID.  454 

 455 

3.2. Standardize and select the troughs in the recorded signal  456 

 457 

3.2.1. Open the standardize_troughs.py icon with the text editor of choice. If there is no 458 

preference, right-click on the script icon and select Open with IDLE.  459 

 460 

3.2.2. In line 158, type the sampling frequency (Sample/second).  461 

 462 

NOTE: This protocol suggests 100 S/s because troughs, which are drops in voltage resulting from 463 

the flag interrupting the IR sensor beam, will still reach a minimum drop in voltage of 0.36 V for 464 

speeds of 1.7 m/s. In turn, noise, which has a maximum drop in voltage of 0.10 V, can still be 465 

filtered during standardizations without filtering real troughs. Additionally, a sample rate of 100 466 

S/s makes it easy for the user to see the troughs on the on-screen waveform during and after 467 

recording. If errors happen during the recording, then the user can quickly discern the troughs 468 

from errors or noise. See Supplemental Figure 3 for comparisons among several low sampling 469 

frequencies.  470 

 471 

3.2.3. In line 159, type the path to the Flight_scripts folder, and run the script. If the script 472 

successfully runs, it generates files in the standardized_files folder in the Flight_scripts directory.  473 

 474 

NOTE: All files should start with the ‘standardized_’ and end with the original filename. 475 

 476 



   

3.2.4. Check the quality of the recordings: Open the trough_diagnostic.png generated by the 477 

standardize_troughs.py located in the Flight_scripts folder. Ensure that all records are robust to 478 

changes in the minimum and maximum voltage value of the mean standardization interval.  479 

 480 

NOTE: Recordings may have a lot of noise or have overly sensitive troughs if they exhibit large 481 

decreases in the number of troughs identified and counted when the minimum and maximum 482 

deviation values are increased. Additional diagnostics for the min-max normalization factor can 483 

also be coded, performed, and plotted. An alternative method for checking recording quality is 484 

described in steps 2.3.1. and 2.3.2. of the Attisano et al. 2015 methods paper13.  485 

 486 

3.2.5. Assess the diagnostics, uncomment out line 198 and specify the minimum and maximum 487 

deviation values, which define the minimum and maximum values around the mean voltage used 488 

to perform the standardization for all files. The default is deviation values of 0.1 V. 489 

 490 

NOTE: In line 53, the user can also specify the min-max normalization factor threshold in order 491 

to identify a voltage far below the threshold value.  492 

 493 

3.2.6. Comment out line 189 after inputting the deviation values, and then run the script. The 494 

script will run the standardizations efficiently for all files (nearly 25 times faster). 495 

 496 

3.3. Analyze the flight track using the standardized file. 497 

 498 

3.3.1. Open the flight_analysis.py icon with the text editor of choice. If there is no preference, 499 

right-click on the script icon and select Open with IDLE.  500 

 501 

3.3.2. In lines 76-78, edit the optional speed correction that suppresses additional rotations of 502 

the mill’s arm after an insect stops flying. Determine this threshold value with caution when 503 

working with slow flying insects. 504 

 505 

3.3.3. In line 121, edit the speed thresholds to correct for false speed readings such as extremely 506 

fast speeds or negative speeds. In line 130, edit the time gap value to filter out long gaps that 507 

occur between two consecutive uninterrupted flying bouts.  508 

 509 

3.3.4. In line 350, type the path to the folder in which the *.txt standardized files are saved. 510 

 511 

3.3.5. In line 353, input the arm radius length used during trials, which defines the circular flight 512 

path flown per revolution by the insect.  513 

 514 

3.3.6. Identify the distance and time SI units as a string in lines 357 and 358. 515 

 516 

3.3.7. In lines 388-397, use the split() function to extract, at a minimum, the insect’s 517 

identification number and the set number and chamber in which the insect flew from the 518 

filename. The script follows the comprehensive filename example of ‘standardized_T1_set006-519 



   

2-24-2020-B.txt’. If necessary, simplify this filename as suggested in step 2.2.5., and comment 520 

out or delete variables like trial type on lines 392 and 401, if not used. 521 

 522 

3.3.8. Specify all the user settings, save and run the script. If the script run is successful, it prints 523 

the insect’s corresponding ID number, chamber, and calculated flight statistics in the Python 524 

Shell. Additionally, it generates a comprised flight_stats_summary.csv file of the information 525 

printed in the Python Shell in the data folder of the Flight_scripts directory. 526 

 527 

REPRESENTATIVE RESULTS:  528 

Flight data were obtained experimentally during Winter 2020 using field collected J. 529 

haematoloma from Florida as the model insects (Bernat, A. V. and Cenzer, M. L. , 2020, 530 

unpublished data). Representative flight trials were conducted in the Department of Ecology and 531 

Evolution at the University of Chicago, as shown below in Figures 6–9. The flight mill was set up 532 

within an incubator set to 28 C/27 C (day/night), 70% relative humidity, and a 14 h light/10 h 533 

dark cycle. For each trial, the flight track of multiple bugs was recorded every hundredth of a 534 

second by the WinDAQ software for up to 24 h. After preliminary trials, flight behavior was 535 

categorized into bursting flight and continuous flight. Bursters flew sporadically for less than 10 536 

min at a time, and continuous flyers flew uninterrupted for 10 min or longer. Any individual that 537 

did not exhibit continuous flight behavior within its 30 min testing phase was pulled off the flight 538 

mill and replaced with a new bug and its accompanying ID in an event marker comment. All bugs 539 

that exhibited continuous flight remained on the flight mill beyond 30 min until they stopped 540 

flying. Bugs were swapped from 8 AM to 4 PM each day. As represented in Figure 9, flight trials 541 

of individuals in a day’s recording varied in length from 30 min to 20+ h. By inserting event 542 

markers at the addition of new individuals, this complex data structure becomes successfully 543 

processed through the Python scripts, and the code effectively helps users visualize the scope of 544 

their experiments. The proposed experimental setup captures the full flight capacity of insects; 545 

however, it omits the possibly of observing flight periodicity. Users then have the option to tailor 546 

their flight trials for different flight metrics and choose which flight behavior or strategies they 547 

most wish to test. 548 

 549 

The on-screen waveform and diagnostic heatmap(s) also make it possible to identify gaps or 550 

resolve inconsistencies in the flight track data. Figure 6A shows a set of trials whose flight data 551 

were successfully recorded for all channels without noise or disruption. It also shows all the event 552 

marker comments made during recording. Figure 6B shows a moment where the recorded signal 553 

was lost in channel 3, dropping the voltage immediately to 0 V. This was possibly due to the 554 

crossing over of open wires or the loosening of wires. There are also particular events during 555 

recording that could occur but are corrected for in the Python scripts. This includes double 556 

troughs, mirror troughs, and voltage noise (Figure 6C,D). These events lead to false trough 557 

readings, but they can reliably be identified and removed during analyses. Figure 7 compares 558 

three data files to show how noise or sensitive troughs in the recording data were diagnosed 559 

during the standardization process. The first (Figure 7A) is a file whose troughs generated by each 560 

revolution of the flight mill arm were robust, meaning they largely deviated from the file’s mean 561 

voltage. In turn, as the standardization interval around the mean increased, there was no change 562 

in the number of troughs identified. This suggested that there was no voltage noise, and the user 563 



   

can then be confident in the accuracy of the standardization. On the other hand, the third file 564 

(Figure 7C) had troughs that were either too sensitive or had extraneous voltage noise that did 565 

not deviate largely from the file’s mean voltage. As a result, its number of troughs decreased 566 

substantially as the standardization interval around the mean increased. It would then be 567 

advisable to look back into the original WDH recording file to confirm whether the insect was 568 

truly flying.  569 

 570 

By plotting the flight speed and duration statistics of the individual, flight behavior can be further 571 

characterized into four flight categories: bursts (B), bursts to continuous (BC), continuous to 572 

bursts (CB), and continuous (C), as represented in Figure 8. An individual that strictly exhibited 573 

continuous flight flew uninterrupted for 10 min or more at least by the end of its 30 min testing 574 

phase (Figure 8A). An individual that flew sporadically throughout its 30 min testing phase 575 

exhibited bursting flight (Figure 8B). An individual that initially exhibited continuous flight for 576 

more than 10 min and then tapered within its 30 min testing phase into sporadic bursts exhibited 577 

continuous to bursting flight (Figure 8C). Finally, an individual that initially demonstrated bursting 578 

flight and then transitioned into continuous flight for the remainder of the 30 min testing phase 579 

and beyond exhibited bursting to continuous flight (Figure 8D). Thus, specific to the model insect 580 

and experimental framework, the user can use this graphic output to assess and identify general 581 

flight behavior patterns despite unique variations in individual tracks. 582 

 583 

FIGURE AND TABLE LEGENDS: 584 

 585 

Figure 1: Designs to be laser cut for acrylic plastic sheet structure. Eight acrylic plastic sheets 586 

were laser cut in order to construct the plastic support structure of the flight mill. File lines were 587 

created in Adobe Illustrator in RGB mode, where RGB Red (255, 0, 0) cut lines and RGB Blue (0, 588 

0, 255) etched lines. For greater legibility in this figure, file line strokes were increased from 589 

0.0001 point to 1 point. Coordinate units are mm, and the dot in the top left corner of each design 590 

is the origin, where moving further down and to the right of the origin leads to positive ascending 591 

values. There are three different sheet designs: the outside vertical walls, a central vertical wall, 592 

and horizontal shelves. The two outside vertical walls slide into the horizontal shelves at their 593 

slits, and their rectangular holes are used to mount the 3-D printed linear guide rail, blocks, and 594 

supports. There is one central vertical wall with slits that divides the flight mill into eight cells and 595 

provides additional structural support. There are also five horizonal shelves with slits, etched 596 

circles to mark the location of the magnetic tube supports, and small rectangular holes to allow 597 

the tube supports to be screwed in.  598 

 599 

Figure 2: Assembled flight mill. A) Flight mill assembly. Each horizonal shelf (HS) has been 600 

inserted into the open slits of the outside vertical walls (OW) and central vertical wall (CW). 601 

Moreover, each cell, or ‘chamber’, is identified with a channel letter (A or B) that corresponds to 602 

a data logger and a channel number (1-4) that corresponds to the channel on the specific data 603 

logger. B) Flight mill cell assembly with flight mill arm. Magnetic bearings can be raised or lowered 604 

by sliding the inner tubes within the outer tubes to adjust the height of the arm. The IR sensors 605 

can be also be raised or lowered to align the sensors with the height of the flag on the arm. IR 606 

sensors can also be removed from their linear guide rail blocks easily if they need to be replaced 607 



   

or inspected or if the flight mill needs to be transported. Cross brackets provide structural 608 

support for each acrylic cell and can be easily inserted and removed. C) Linear guide rail and block 609 

assembly in the cell window. All 3D components and respective screws in the cell window are 610 

labeled for clearer assembling.  611 

 612 

Figure 3: 3D printed designs. Measurements are in mm. A) Linear guide rail. B) Linear guide rail 613 

block shaped to hold an IR sensor. C) Screw used as support to replace iron screws. D) Tube 614 

support. E) Magnet support. F) Cross bracket used as an acrylic frame aligner and stabilizer. G) 615 

Long support and H) short support to keep the linear guide rails in place. Only linear guide rail 616 

supports that rest on the outside face of the acrylic wall are shown. Linear guide rail support 617 

mirrors are not shown. 618 

 619 

Figure 4: Flight mill electrical circuitry. A) Simple diagram of an electric circuit connecting the IR 620 

sensors to the data logger. When the flag on the mill arm interrupts the beam emitted by the IR 621 

sensor transmitter, the current stops flowing to the IR sensor receiver and the voltage drops to 622 

zero. The data logger records all drops in voltage. B) Electrical circuits highlighted. Each yellow 623 

box delimits the components of a circuit connected to the breadboard. Multiple electric circuits 624 

can be connected to a single breadboard in alternating rows. The size of the solderless 625 

breadboard limits how many flight cells can be accommodated. 626 

 627 

Figure 5: Insects of different sizes magnetically painted and tethered. A) Drosophila 628 

melanogaster (common fruit flies) magnetically painted and tethered. Fruit flies are small insects 629 

(body length  5 mm; mass = 0.2 mg) that need to first be anesthetized with ice or CO2 under a 630 

microscope before applying the magnetic paint to their thorax. B) Mismatch between insect size 631 

and magnet size. The magnet on the flight mill arm should best accommodate the size of the 632 

insect. Here the insect’s field of vision is obstructed because the magnet is too large. A smaller 633 

conical magnet or magnetic strip would solve this mismatch. C-F) Oncopeltus fasciatus (milkweed 634 

bugs) and Jadera haematoloma (soapberry bugs) magnetically painted and tethered. Larger bugs 635 

(body length > 5 mm; mass > 0.1 g) can be pinched by their legs before applying a coat of paint 636 

on their thorax.  637 

  638 

Figure 6: Examples of WDH flight recordings. Voltage troughs represent complete revolutions of 639 

the flight mill’s arm. The red dotted lines divide the display, and the seconds-per-division 640 

(sec/div) of each panel are highlighted in blue. Black vertical lines mark the cursor time. A) Event 641 

markers. The sec/div was changed from 0.2 sec/div to its max, allowing the entire waveform to 642 

be drawn across the screen. All event markers taken across all channels will only be visible in the 643 

first channel as lines that run from the max voltage to the bottom of the channel field window. 644 

All event makers for this recording set are within the yellow oval. B) Signal loss. In another 645 

recording set, the sec/div was changed from 0.2 sec/div to 15 sec/div to help visualize a recorded 646 

signal lost from 17:09 to 17:15 in channel 3. All other channels such as channel 4 continued to 647 

function properly. C) Double troughs and mirror troughs. Double troughs are when the voltage 648 

dips, rises, and then quickly dips and rises again to create what appears to be two merged troughs 649 

in one beam-breaking event. The double troughs also mirror one another, which suggests that 650 

the flag moved back and forth between the sensor, which usually happens when an insect stops 651 



   

flying. The Python scripts correct for each case. D) Voltage noise. Soon after 13:14, small bumps 652 

in the voltage can be seen, which suggest voltage noise in the recording. 653 

 654 

Figure 7: Representative trough diagnostic data from Jadera haematoloma (soapberry 655 

bug). Potential noise or overly sensitive troughs are readily recognized in the flight 656 

recordings. A) An optimal, robust recording from example individual 318. There was no change 657 

in the number of troughs as the minimum and maximum deviation values increased, and so the 658 

troughs were robust enough to be identified despite a large standardization interval. B) A sub-659 

optimal, but still robust recording from example individual 371. There is a drop in the number of 660 

troughs as the minimum and maximum deviation values increased; however, the drop was 661 

minimal (8 troughs). There could be noise and some sensitive troughs but nothing substantial. C) 662 

A noisy recording from example individual 176. There is a clear and rapid drop in the number of 663 

troughs identified as the minimum and maximum deviation values increased until its number 664 

plateaus at 12 troughs. This signals a lot of potential noise or overly sensitive troughs while the 665 

12 troughs remain as robust troughs.  666 

 667 

Figure 8: Representative flight data from Jadera haematoloma (soapberry bug). Four categories 668 

of flight behavior can be identified in the flight recordings. A) Continuous flight. This individual 669 

flew continuously for 1.67 h, beginning at high speeds and then tapering over time into lower 670 

speeds. B) Bursting flight. This individual flew only in bursts within the first 30 min of their trial. 671 

Bursters can reach high speed but this individual could only retain low speeds. C) Continuous to 672 

bursting flight. This individual had maintained continuous flight for 25 min and then tapered off 673 

into bursts for the remaining 5 min of their trial. D) Bursting to continuous flight. This individual 674 

begun as a burster, reaching high sporadic speeds, and then transitioned into continuous flight 675 

for about 4 h. 676 

 677 

Figure 9: Representative channel visualization of multiple flight trials within a single recording 678 

set. Each color represents an individual soapberry bug, Jadera haematoloma, at its given channel 679 

letter and channel number during its trial. All start times, stop times, and filenames were 680 

extracted from each individual’s unique flight track txt file. 681 

 682 

Supplemental Figure 1: Kerf key. Kerf is the thickness of the material removed or lost in the 683 

process of cutting that material. For a laser cutter, two important factors will determine the width 684 

of the kerf: the beam width and the material type. To test and calculate the exact kerf, laser cut 685 

the key and fit the 20 mm width key into the slot that it fits most securely. Then, subtract the slot 686 

width value from the key width value. For example, a key with a width of 20 mm that fits into a 687 

19.5 mm slot will have a kerf thickness of 0.5 mm.  688 

 689 

Supplemental Figure 2: Flowchart of the functions and data structures of each Python script. 690 

An overview of the inputs, functional processes, and outputs of each Python script for the 691 

proposed flight mill is summarized and described through examples. 692 

 693 

Supplemental Figure 3: Comparison of low sampling frequencies. A) Relationship between 694 

voltage drop and speed by sampling frequency. Each color and shape represents a sampling 695 



   

frequency (100 Hz, 75 Hz, 50 Hz, and 25 Hz). Voltage drop is synonymous with the size of the 696 

trough. Lines fit second order regressions, which describe the decrease in trough size as speed 697 

increases and the following rise in trough size at higher speeds. The shaded bar runs from 0 V to 698 

0.1 V, which marks the voltage range in which noise occurs. Data were collected on cell B-4 using 699 

the WinDAQ recording software and with foil flag dimensions 30 mm length by 30 mm width. 700 

The flight mill arm was spun rapidly by hand and left to spin until it stopped moving. Sampling 701 

frequencies 25 Hz or lower are in danger of misidentifying troughs as noise during standardization 702 

and diagnostic tests. Sampling frequencies of 100 Hz or higher are especially robust at recording 703 

large troughs for speeds less than 1 m/s. B) Trough sizes of different sampling frequencies seen 704 

through the waveform. As the sampling frequencies decrease, their representation on the 705 

waveform also shrinks. 706 

 707 

DISCUSSION:  708 

The simple, modern flight mill provides a range of advantages for researchers interested in 709 

studying the flight behavior of a model species by delivering a reliable and automated design that 710 

tests multiple insects efficiently and cost-effectively13,31,35. Likewise, there is a strong incentive 711 

for researchers to adapt to fast-emerging technologies and techniques from industry and other 712 

scientific fields to design and build experimental tools to study ecological systems9,32,33. This 713 

protocol takes advantage of two rapidly emerging technologies, the 3D printer and the laser 714 

cutter, which are becoming increasingly available in communal makerspaces, in order to enhance 715 

the simple, modern flight mill. These enhancements provide a more flexible, adjustable, and 716 

collapsible design that accommodates insects of different sizes, minimizes stress placed on the 717 

insect, and allows the flight mill to be transported easily to multiple locations or environments. 718 

Furthermore, the additional expenses of using the technologies are minimal or even free. 719 

However, these technologies can also be a challenge to experiment with if reaching proficiency 720 

in using vector graphics editors and 3D image software is not readily available. In turn, the flight 721 

mill presented here serves to both encourage researchers to incorporate available emerging 722 

technologies in their workflow and to allow researchers to build a customizable, flexible, and 723 

effective flight mill without specialized knowledge of electronics, programming, or computer-724 

aided design (CAD) models. 725 

 726 

The strongest aspects of this protocol are the makerspace’s technologies that expand a user’s 727 

flight mill design options, the use of magnetic paint to minimize insect stress, and the automation 728 

of flight recordings that processes multiple insects within a single recording. The laser cutter 729 

offers precise and exact cutting capabilities that can handle jobs of almost any complexity. The 730 

user can modify the acrylic support structure to mount additional 3D prints or purchased items. 731 

The 3D printer allows the user to create customizable flight mill components that can bypass 732 

costly, pre-made products with narrowly adjustable dimensions. 3D prints not proposed in this 733 

paper can also be built, such as landing platform, supports that can quickly exchange between 734 

magnetic bearings and ball bearings, or even a new attachment that tethers an insect. Finally, 735 

the use of automated recording software and Python scripts to differentiate multiple flight trials 736 

within a single recording makes it possible to study sporadic bouts of flight to very long bouts of 737 

flight. However, given how variable flight activity and duration is across species, it is suggested 738 

that the user conducts preliminary trials in order to understand the limits and general patterns 739 



   

of a species’ flight behavior so as to optimize data collection. The user can also assess the integrity 740 

of their recordings using the diagnostic heatmap(s) and can account for any necessary speed 741 

corrections in the scripts. 742 

 743 

Researchers should also be aware of the flight mill’s general constraints. Previous studies have 744 

made known and have attempted to remediate the limitations of tethered flight, including a lack 745 

of tarsal contact to allow the insect to rest at will18,31, the absence of energy expended when an 746 

insect takes-off34, the additional drag the insect overcomes when pushing the flight mill arm, and 747 

the insect needing to compensate for the outward aerodynamic forces experienced due to the 748 

centrifugal acceleration of its circular flight track6,35. Additionally, there continue to be 749 

inconsistencies on how to categorize or more precisely quantify the short or ‘trivial’ bursts insects 750 

display, especially when comparing the flight behavior and mechanisms of large migratory insects 751 

to those of small insects who exhibit mostly hovering flight24,36,37. Despite these limitations, there 752 

has been significant progress in capturing and categorizing flight behavior within insect species, 753 

and researchers have continued to couple the flight mill with other technologies and methods6-754 
8.  755 

 756 

The makerspace as a location of creativity, collaboration, and low barriers will further inspire 757 

researchers to troubleshoot 3D print design limitations or laser cut more intricate designs. 758 

Studies have surveyed the effectiveness of makerspaces not just as iterative product-making 759 

spaces but also as places of accelerated learning10–12. Engineering students overall scored higher 760 

in design comprehension, design documentation, and model quality when their designs were 761 

made using makerspace technology11. Additionally, their model development time dropped by 762 

50%, indicating that makerspace exploration outperformed traditional rote theory and 763 

application coursework11. In turn, researchers with little design knowledge will be able to deepen 764 

it, and researchers who are also educators can take advantage of this space as a means to 765 

increase design organization, craftmanship, and technical dexterity for students. In a discipline 766 

like ecology that already makes use of a variety of tools for field and laboratory work, researchers 767 

can also develop, share, and standardize novel or enhanced tools. The flight mill proposed in this 768 

paper is only the start of what could be an approach to democratizing and rapidly spreading new 769 

means of collecting data.  770 

 771 

Flight mills have played an important role in enabling researchers to understand the dispersal of 772 

insects – an ecological phenomenon still essentially intractable in the field. Future advances in 773 

the design and application of the flight mill can be achieved as researchers become more 774 

proficient in emerging technologies and the software accompanying those technologies. This 775 

could include designing flight mill arm bearings that allow vertical lift or gives the insect greater 776 

flight orientation flexibility. Additionally, the precision of laser cutters and 3D printers may be 777 

necessary for researchers interested in scaling down and calibrating for small insects with mostly 778 

hovering capabilities. In turn, the goal of this protocol was to provide an easy entry to these 779 

technologies while constructing one of the most common and useful devices in the field of 780 

behavioral ecology – the flight mill. If researchers have access to a communal makerspace and 781 

are committed to navigating its technologies, the resulting enhancements and improvements of 782 

the modern flight mill will lead to creative and collaborative flight mill design and will continue 783 



   

to offer insights into the underlying traits and mechanisms that influence insect species’ 784 

variations and patterns in movement.  785 
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Name Company Catalog Number

180 Ω Resistor E-Projects 10EP514180R

19 Gauge Non-Magnetic Hypodermic Steel 

Tubing

MicroGroup 304H19RW 

2.2 kΩ Resistor Adafruit 2782

3D Printer FlashForge 700355100638

3D Printer Filament FlashForge PLA-1KG

3D Printing Slicing Software FlashPrint 4.4.0

Acrylic Plastic Sheets Blick Art Supplies 28945-1006

Aluminum Foil Target 253-01-0860

Breadboard Power Supply HandsOn Tech MDU1025

DI-1100 USB Data Logger DATAQ Instruments DI-1100

Electrical Wires Striveday B077HWS5XV

Entomological Pins BioQuip 1208S2

Filtered 20 uL Pipette Tip Fisher Scientific 21-402-550

Hot Glue Gun with Hot Glue Joann Fabrics 17366956

IR Sensor Adafruit 2167

Large Clear Vinyl Tubing Home Depot T10007008

Large Magnets Bunting EP654

Laser Cutter Universal Laser Systems PLS6.75

M5 Hex Nut Home Depot 204274112

M5 Long Iron Screws Home Depot 204283784

M5 Short Iron Screws Home Depot 203540129

Neoprene Rubber Sheet Grainger 60DC16

Power Adaptor Adafruit 63

Small Clear Vinyl Tubing Home Depot T10007005

Small Magnets Bunting N42P120060

Solderless MB-102 Breadboard Adafruit 239

Sophisticated Finishes Iron Metallic Surfacer Blick Art Supplies 27105-2584

Wire Cutters Target  84-031W
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Comments

Carbon film; stiff 24 gauge lead.

Carbon film; stiff 24 gauge lead.

Diameter 1.75 mm; 1kg/roll.

Can take 6.5V to 12V input and can produce 3.3V and 5V. 

Has 4 differential armored analog inputs.

24 gauge solid wire.

Size 2; diameter 0.45 mm.

This is the 3 mm IR version; works up to 25 cm.

Inner diameter 3/8 in; outer diameter 1/2 in; length 20 ft.

Low-friction N42 neodymium; diameter 0.394 in; length 0.157 in; holding force 

4.9 lb. 

Thread pitch 0.8 mm; screw length 20 mm; diameter 5 mm. 

Philips pan head; thread pitch 0.8 mm; screw length 20 mm; diameter 5 mm.

Philips pan head; thread pitch 0.8 mm; screw length 10 mm; diameter 5 mm.

Length 12 in; width 12 in; depth 1/8in.

9 VDC 1000mA regulated switching; input voltage DC 3.3V 5V.

Inner diameter 1/4 in; outer diameter 3/8 in; 20 ft long.

Low-friction N42 neodymium; diameter 0.120 in; length 0.060 in; holding force 

0.5 lb.830 tie points; length 17 cm; width 5.5 cm; input voltage, DC 3.3 V 5 V. 



To Dr. Vidhya Iyer and the four anonymous reviewers: 

 

Thank you for all of your productive comments. I truly appreciated the diversity and depth of 

your questions. I have addressed each comment and believe it has resulted in dramatic 

improvements to this manuscript. I summarize the major changes I made below, and then I 

address each individual comment. 

 

Major changes: 

 

1. In the introduction and discussion, I have added new paragraphs that describe the 

educational and research benefits of makerspaces.  

2. I have revised and added new figures. Figure 5 shows how to apply magnetic paint on 

insects of different sizes and how to (and how not to) tether them. Figure 7 showed line 

graphs before but it now shows heatmaps for the trough diagnostics. Supplemental Figure 

2 shows a comprehensive flowchart of the main functions and data structures of each 

Python script. Supplemental Figure 3 shows a comparison between low sampling 

frequencies in order to help users decide which sampling frequency is best for their 

experiments. 

3. I have corrected for grammar, SI units, and abbreviations as well as formatted references 

and figures to match submission guidelines. 

4. I have added additional specifics on the IR sensors, masses of moving parts, dimensions 

of the foil flag or 3D prints, and experimental setup. 

5. I have added new reference material based on reviewers’ insightful recommendations. 

This has included four papers on the benefits of makerspaces, three papers on ball 

bearings, and two papers on dispersal theory and application. 

 

Individual comments (reviews in italics; responses in plain text): 

 

############################################################################## 

 

Editor: 

 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are 

no spelling or grammar issues. 

 

Improved. 

 

2. Please revise the following lines to avoid previously published work: 74-75, 250-259 

 

Revised.  

 

3. Please revise the title for conciseness. “Benefits of Makerspaces” can be removed. 

 

I removed “Benefits of Makerspaces” from the title, but I wonder if readers would want to know 

where the enhancements of the machine can be primarily built. Readers could build their flight 
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mill in other contexts if that context also has the available technology, but the makerspace is 

unique and versatile as a space of creation.  

 

4. Please refrain from using personal pronouns: I, we, etc. 

 

I removed and rephrased all appearances of personal pronouns, except in the 

Acknowledgements. Please let me know if the Acknowledgements section needs to be revised.  

 

5. Please define all abbreviations before use (3D, IR, RGB). 

 

Corrected. 

 

6. JoVE cannot publish manuscripts containing commercial language. This includes trademark 

symbols (™), registered symbols (®), and company names before an instrument or reagent. 

Please remove all commercial language from your manuscript and use generic terms instead. All 

commercial products should be sufficiently referenced in the Table of Materials (e.g., Universal 

Laser Systems, FlashPrint, FlashForge, Finder 3D Printer,) 

 

References to commercial products in the manuscript have been removed. Readers will instead 

reference the Table of Materials if curious about which specific products the manuscript was 

modeled by.  

 

7. Line 170-175: Please include the specifications for the linear guide rails, linear guide rail 

blocks, screws, cross brackets, magnet holders, tube supports, guide rail supports, etc.  

 

I added dimensions (i.e. length x width x depth) for each 3D printed design in step 1.2.3. To see 

nuanced details of the designs, readers can view Figure 3. Otherwise, please let me know 

whether these are sufficient specifications.  

 

8. Please use standard abbreviations for SI units throughout the protocol. Examples: 10 min, 5 

h. 

 

Corrected. 

 

9. Please name and specify the supplementary files used throughout the manuscript: 

Supplementary File in line 131. 

 

Corrected. 

 

10. Step 2: Please specify the insect used in the protocol. This data is on line 459. Please move it 

up to the protocol so we can include this information in the filming.  

 

I now mention Jadera haematoloma (soapberry bug) in step 2.1.1.  

 

11. Please consider moving Discussion of figures from the figure legends to Representative 

Results (Figure legend 6). 



 

Revised. Also, what was once Figure 6 is now Figure 7, and it shows heatmaps instead of line 

graphs.  

 

12. Figure 4: Please define the yellow boxes in the Figure legends. 

 

I added this definition.  

 

13. Please sort the table of materials in alphabetical order. 

 

Sorted. 

 

############################################################################## 

 

Reviewer #1: 

 

1. The literature review for this paper seems to be not very comprehensive. The reviewer 

recommends citing and discussing recently-published peer-reviewed documents related to make 

movement and the positive impact of makerspaces in education. Documents listed below can be 

considered relevant (or other relevant documents based on the author’s judgment:  

 

https://search.proquest.com/docview/1774311185?pq-origsite=gscholar&fromopenview=true 

https://www.mdpi.com/2227-7102/10/1/8 

Makeology: Makerspaces as Learning Environments (Volume 1), Volume 1 

 

I appreciated this comment and enjoyed reading literature on the maker movement. I included 

more information on the many impacts of makerspaces in the introduction and discussion.  

 

2. Parts of this paper (Sections 1-3) does not follow the format of a peer-reviewed publication, 

and looks like a experimental manual. The reviewer feels that these parts need to be rewritten in 

the format of a paper by adding more introductory and analyzing paragraphs and removing the 

details of experiments. 

 

In response to this and another reviewer’s comment, I added more analysis about the benefits and 

disadvantages of the flight mill I constructed and of alternative flight mills. I also removed 

extraneous details of the experiments in the Discussion, but, in response to other reviewers, 

added more pertinent experimental details. 

 

3. Results in some of the figures of this paper are not discussed properly. A good technique to 

use for figures and tables is sandwiching where the figure or table is introduced in the text, and 

is fully discussed after the figure or table. I recommend adding analyzing comments for the 

figures. 

 

I added more comments that aligned with the new figures and new figure edits, but I would also 

like to hear more about where an analyzing comment goes. When is it best for analyses to be 

embedded in text and when in figures?  

https://urldefense.com/v3/__https:/search.proquest.com/docview/1774311185?pq-origsite=gscholar&fromopenview=true__;!!BpyFHLRN4TMTrA!qpY47vyibdPOeVfhmT4UDWC4mZjZ8ZdGFk3U-DFnnMAZpRtbbixjdLs9L5CUV34nrRs$
https://urldefense.com/v3/__https:/www.mdpi.com/2227-7102/10/1/8__;!!BpyFHLRN4TMTrA!qpY47vyibdPOeVfhmT4UDWC4mZjZ8ZdGFk3U-DFnnMAZpRtbbixjdLs9L5CUX6n0FaI$


 

4. Figures need proper caption.  

 

I added a short title and short description for each panel in each figure where it was omitted 

before. This included Fig 2C, Fig 4A, Fig 4B, Fig 6A, Fig 6B, Fig 8A, Fig 8B, Fig 8C, and Fig 

8D. 

 

5. Does the comments at the end of the paper add any important practical value to the paper? I 

feel they can be removed. 

 

I cut extraneous comment descriptions and retained comments that I thought would be most 

useful for a first time user of electrical/mechanical tools/equipment.  

 

6. I recommend putting the list of the material in the format of a table. 

 

Converted to CSV file now. 

 

7. Coding files have been provided as supplementary material. I feel the author can add 

pseudocode(s) or flowchart(s) for these codes in the paper. 

 

I added a pseudocode/flowchart for the code (Supplemental Figure 2), but I still left it as 

supplementary material because there was a lot to distill into one diagram. It could be distilled 

even further if reviewers want a more representational (not supplementary) figure in the paper.  

 

8. There seems to be some punctuation, grammar, and formatting errors in the paper. Please 

proofread and comply by the template’s format. 

 

Revised. 

 

9. Figures 4, 5, 8, and supplementary figure 1 can be resized. They seem to be unnecessarily big. 

 

Revised. 

 

10. Can the author add couple of paragraphs on the effectiveness of the makerspace for 

education purpose. Are there any surveys or results that show the effectiveness of this work? 

 

I added new paragraphs in the introduction and discussion explaining survey results and course 

results on how effective makerspaces are in the classroom. 

 

############################################################################## 

 

Reviewer #2: 

 

1. L131. It is a good idea to add a kerf key. 

 



Agreed. Laser kerf is especially variable, and kerf keys help users see exactly which laser 

settings work best for the construction of major designs. Without knowing precise settings, you 

are very likely to underestimate or, worse, overestimate the size of holes in a design, which will 

end up removing too much material for the building material to be constructible or correctable 

anymore. This wastes a lot of useful building material that was meant to be used for the main 

project. 

 

2. Fig 1. Could you add the location of the square and rectangular holes on the Outside Vertical 

Wall, as well as the location of the holes on the Horizontal Shelves? 

 

Good question - I added a vertex coordinate for each hole in the Outside Vertical Wall and 

Horizontal Shelf designs. For greater figure legibility, I did not include units in the coordinates 

but defined the units in the figure description. Please let me know if the units need to be included 

in the figures. Additionally, I marked an origin for each design and updated its corresponding 

figure description to match the designs.  

 

3. Fig 3. L534. Is not H the mirror of G?  

 

It looks like it but it is not. H is a short linear guide rail support (11.00 mm width) and G is a 

long linear guide rail support (16.00 mm width) because of their different widths. However, this 

image is confusing because each rail support rests on a different side of the acrylic wall. H rests 

on the outside of the acrylic wall and G rests on the inside. To avoid this confusion, I now show 

the same-sided version of each support and specify between ‘short’ and ‘long’ support in the 

figure description. 

 

4. L173 and L237. What is the difference between short and long linear guide rail support? If 

they refer to designs G and H, maybe use 'linear guide rail support 1' and 'linear guide rail 

support 2'. 

 

See response to third question above on clarifying rail supports. I did not take up this suggestion, 

but potentially renaming the shorter linear guide rail, ‘linear guide rail support 1’, and the wider 

linear guide rail, ‘linear guide rail support 2’ is still a good idea. I left the names descriptive so 

they can hint to users what the difference between the rail supports is.  

 

5. In the case of first-time users of 3D printing, it would to add that it is possible to print several 

parts at the same time if they fit on the build area.  

 

Valuable suggestion - I added a note for first-time users at step 1.2.2. This will not only help 

first-time users customize their .STL files early on to help them save time, but it will also help 

them foresee potential pitfalls in rotating designs along the z-axis. 

 

6. L214-215. The horizontal shelves have to be put in the correct position so the holes are 

aligned. 

 

Also important – I added a new sentence in step 1.1.8. that tells users, during the assembly of the 

acrylic support structure, to make sure that the holes between horizontal shelves are aligned. 



 

7. L242-244. Good idea! 

 

Thank you! 

 

8. L291. As one of the strongest aspects of the protocol (L604), it would be informative to have a 

picture of the mill with an insect tethered with magnetic paint in order to have an idea of how it 

differs from gluing. 

 

I added a new figure (Figure 5) that shows how to apply the paint to insects of different sizes. 

 

9. Fig 5. Why are all the event markers of all channels displayed in channel 1? Is there any 

benefit of this method instead of displaying the event markers in their corresponding channel? 

 

Rather than a benefit, it is a limitation by the WinDAQ software. As far as I know and after 

trying multiple tools on the software, there is no way to attach event markers to their 

corresponding channel. Additionally, I found no way to export the data with a column that 

identifies which channel the event marker was made. I found a way around that by recording ID 

and channel number by hand and writing the split_files.py script, but I would also love to put 

those event markers directly into the corresponding channel. 

 

10. L546. There should be the time scale on the horizontal axis. 

 

I decided against a direct time scale on the horizontal axis. By that I mean, I did not label each 

division with its time, but trusted that the user would see the reference times I label more clearly 

now. Mostly, I want the readers to understand the seconds-per-division (sec/div) variable. I do 

want the figure to be legible, but I also want it more to be a quick representational guide to 

identifying possible abnormal behavior in the flight recordings. If this figure needs to be more 

legible, please let me know. 

 

11. Fig6. I thought there were two lines in the graphs of Fig 6.A because the number of troughs 

overlap. Could you suppress them? 

 

What was once Figure 6 has been updated to be heatmaps instead of line graphs. These heatmaps 

are much clearer to read and identify noise with. 

 

12. L498. Should it be ‘continuous flight to bursting’ instead of ‘bursting to continuous flight’? 

 

Yes – it has been corrected. 

 

############################################################################## 

 

Reviewer #3: 

 

1. The bibliography is cited in the text using numbers, but in the Reference chapter there are no 

numbers, so it is very hard to consult the bibliography while reading the document. 



 

I added reference numbers. 

 

2. In the introduction it would be interesting to mention alternatives to magnetic levitation, like 

the use of ball bearings as in [1,2] (see below) 

 

I really enjoyed reading these pieces you suggested. I added a new introductory paragraph that 

weighs the pros and cons of different flight mill mechanics. 

 

References of flight mills using ball bearings: 

=============================================== 

[1] Dubois, G.; Vernon, P.; Brustel, H. A flight mill for large beetles such as Osmoderma 

eremita (Coleoptera: Cetoniidae). In Saproxylic Beetles. Their Role And Diversity in European 

Woodland and Tree Habitats; PENSOFT Publishers: Sofia, Bulgaria, 2009; pp. 219-224 

[2] Martí-Campoy, A.; Ávalos, J.A.; Soto, A.; Rodríguez-Ballester, F.; Martínez-Blay, V.; 

Malumbres, M.P. Design of a Computerised Flight Mill Device to Measure the Flight Potential 

of Different Insects. Sensors 2016, 16, 485. 

 

 

3. The dimensions of the counterweight are not detailed in the document. Although it is assumed 

this can be found in Supplemental Figure 1, the author has to clearly state its dimensions or 

refer to this figure in the text. 

 

Dimensions of the counterweight will vary based on the weight of the insect. To guide the 

reader, I added the mass per area (g/cm2) of the foil in step 1.4.4. 

 

4. Although the sample frequency of the datalogger can reach up to 40KHz using its four 

channels (from the technical documentation of the datalogger referred in the paper), the 

experiment section states the sampling frequency is just 0.1KHz. This is a relatively low 

frequency and forces the counterweight flag to interrupt the infrared beam for at least 10ms. Did 

the author calculate the maximum speed an insect can fly without missing turns (turns which are 

not captured by the datalogger due to a reduced sampling freq)? From the flight angular speed 

and counterweight flag size a minimum time window can be deduced and some calculations can 

be carried out to relate max flight speed, flag size and sampling frequency. The author must give 

some indication on how to tune the width of the counterweight and the minimum sampling 

frequency for a maximum flying speed. Please, check section 3.2 in [2]. This information is 

crucial for researchers interested in the use of the described flight mill for a potentially wide 

range of insects and relates to comments (5) and (6). 

 

I added a new note describing the minimum width of the counterweight in step 1.4.4. I also 

tested different low sampling frequencies for this given circular flight path: 0.6283 m. These 

tests are now plotted in Supplemental Figure 3, and they help researchers decide which sampling 

frequency best suits their test insect.  

 

5. Is the size of the counterweight related to the mass of the insect tethered to the mill? If this is 

not the case, a combination of a low mass insect and a large counterweight may be too 



unbalanced to let the insect fly normally, it may affect the rotation of the arm or the effort the 

insect is required to exert in order to fly. If both are related (as they should be, from this 

reviewer's point of view) an insect with low mass requires a small counterwieght; in this case, 

will the small counterweight interrupt the infrared beam clearly enough to be recognized? 

 

Yes, the counterweight is positively related to the mass of the insect tethered to the mill. The 

diameter of the IR beam is at most 2.4 mm. As long as the flag is at least 2.4 mm wide (3 mm is 

a much more optimal minimum width), aligned in front of the emitter lens that sends out the 

beam of IR light as the arm rotates between the sensors, and – this is key – the flag is made out 

of aluminum (AI flag = 1e-4 g/mm2), then a clear drop in voltage from around 5V to near 0V 

will be produced. This drop in voltage will be soundly detectable as a trough in the Python 

standardize script. However, if the flag is made out of a less reflective material like masking 

tape, then it will take a much larger flag and multiple layers of material to break the beam. This 

will then lead to a heavier flight mill arm and a stronger weight imbalance between the flag and 

the insect on opposite ends of the arm. I added a note in step 1.4.4. that includes these limits. 

 

6. Related to the size of the insect, could a big enough insect disrupt the beam and count false 

turns? And also, could a big insect hit the lateral wall? The side of the arm where the insect is 

attached may be shortened to avoid the insect disrupting the beam or crashing or rubbing some 

of the elements in the wall, but the other side with the counterweight must keep its length to 

allow the disruption of the infrared beam. Is there any effect of this asymmetry taken into 

account in the measurements? 

 

Adjusting the arm is one way to prevent a big insect from hitting the lateral wall or the sensors. 

This was a particular issue I bumped into during the first prototype when I noticed that the 

soapberry bugs were able to reach the sensors with their legs. They then would dismount 

themselves from the arm. I then found an alternative: making the position of the sensors flexible 

by 3D printing a linear guide rail and sensor holders. These allow the IR sensors to be realigned 

at various positions in order to prevent the bug from latching onto a sensor or potentially 

disrupting the sensor with their own bodies. Another alternative, which is not demonstrated here 

but could be done in theory, is to redesign a new sensor that could reposition the sensor holder 

more inwards into the cell. Then, the user can elevate the magnet holders higher and bend the 

hypodermic tubing even closer to its midpoint so that the insect is far below the sensors. That 

way, the arms will still be symmetrical. Here is a small schematic diagram to show: 

 

 
 



The downside of this alternative is that you may need multiple sensor holder prototypes in order 

to accommodate different insects. But since the holders can be easily slide in and out of the 

linear guide rail, it makes it more manageable. 

 

Finally, no effect of asymmetry has been taking into account as of so far. The soapberry bugs 

were tested on a symmetrical flight mill arm. For bugs of different sizes, this was achieved by 1) 

moving the sensors up or down so bugs couldn’t reach the sensors to dismount themselves and 2) 

making sure the flag was horizontally balanced with the counterweight flag.  

 

7. In order to record events from the installation of the eight mills described in the work the use 

of two dataloggers is needed (from the documentation of the datalogger there is a maximum of 

four input channels). Is the WinDAQ Software able to seamlessly work with the two dataloggers 

at the same time? It would be possible to connect more dataloggers to same computer? To have, 

say, 16 mills? 

 

Yes, the WinDAQ Software will open a window for each datalogger connected to the computer. 

Each window can run, collect, and display data simultaneously. Therefore, the only limitation 

one would have is how many USB ports are free on the computer. If one needed to hook up 16 

cells (or two flight mill machines) to a single computer with two data loggers per mill, then the 

user would either need to invest in a multi-port USB hub or invest in a datalogger that can hold 

more than four input channels (some have 8 or 16 analog inputs). If the user invests in a 16 

analog logger then there is the disadvantage of all cells having to be close to each other because 

their circuit wires would all connect to one logger. The ideal then would to have two data loggers 

with 8 inputs, so that each machine can more easily separate from one another if necessary.  

 

8. The author must indicate the weight of the mobile elements, individually or at least in total. 

This mass can affect the capacity of the tethered insect to start the flight because of the moment 

of inertia. 

 

A flight mill arm (with magnets and without a flag) weighs about 1.4 g. I added this information 

in step 1.4.4 for the reader. The flag mass can vary based on the mass of the tethered insect. 

 

References of flight mills using ball bearings: 

=============================================== 
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Woodland and Tree Habitats; PENSOFT Publishers: Sofia, Bulgaria, 2009; pp. 219-224 

[2] Martí-Campoy, A.; Ávalos, J.A.; Soto, A.; Rodríguez-Ballester, F.; Martínez-Blay, V.; 

Malumbres, M.P. Design of a Computerised Flight Mill Device to Measure the Flight Potential 

of Different Insects. Sensors 2016, 16, 485. 
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Major Concerns: 

The manuscript has a clear and focused improvement on a well established technique. Flight 

mills, despite being around for 6 decades, are still shrouded by rare parts and expertise, not to 

mention high costs in commercial systems, making them inaccessible to a vast majority of 

researchers. By using new techniques and open source tools, this protocol democratizes 

researchers' access to flight mills. Laser cutting coupled with 3d printing enables speed and 

design complexity simultaneously which individually isn't possible. 

 

Thank you! The integration of open source tools in science is powerful and exciting.  

 

1. The manuscript claims the design works with diverse insects sizes which is a great feature. 

However, this had not been demonstrated. It would be beneficial to provide examples with 

insects of different sizes/weights, and describe, the adjustments needed in the configuration.  

 

Valuable suggestion – I added a new figure (Figure 5) that shows how one would go about 

testing an insect as small as a fruit fly and as large as a soapberry bug or milkweed bug. I show 

steps where the user would magnetically paint the insects and then show how the insects would 

look attached to the flight mill arm. In theory, even larger insects would be possible, but this has 

not been tested, so instead I offer a schematic (see response to Reviewer #3, comment 6). 

 

2. Secondly. the manuscript does not detail the tethering process itself very easily for replication 

(section 2.1). The use of the magnetic paint is very clever, but how should you add it? How much 

of the pronotum should be covered? How do you tether the insects securely and without injury? 

Does angle of their body or positioning matter? Do you use ice or CO2 as an anesthetic? How 

do you attach them to the device? This should be explained in more detail for new readers who 

may have little experience in tethering experiments. 

 

Figure 5 also shows and describes how to paint different insects without injury. In the figure 

legend, I give an example of mistakes that can be made if, for instance the insect’s field of vision 

is not taken into account. 

 

3. Third, the experimentation needs more detail. It is a bit mysterious as of now. For example, ln 

466-471: "Any individuals that did not exhibit continuous flight behavior at least within the last 

10 minutes of its 30 minute testing phase were pulled off the flight mill and replaced with a new 

bug and its accompanying ID in an event marker comment. All bugs that exhibited continuous 

flight remained on the flight mill beyond 30 minutes until they stopped flying. Bugs were 

swapped until 4 PM each day. As represented in Figure 8, flight trials of single individuals in 

one day's worth of recording varied in length from 30 minutes to 20+ hours and were routinely 

asynchronous." Please describe the difference between continuous and asynchronous flight in 

this context to clarify for new users. Is there likely to be a difference between an insect that has 

flown for 30 minutes vs one for several hours? Does the latter mean you retested insects (since 

the testing period was 30 minutes), or just kept recording them? Is this variance a good practice 

for measuring flight behavior? 

 

Yes, asynchronous flight meant that I gave insects multiple attempts to fly continuously in that 

30 min testing phase. However, I realize that the word could be seen as archaic and not as 



important as the observation of different flight behaviors, so I removed it. Instead, I defined 

bursting and continuous flight earlier on in the experimental description (now in the first 

paragraph of the representative results). This could help clarify why insects were given a 30 min 

testing phase. 

 

Also, interesting final question – some research will restrict their trial lengths and permit insects 

to attempt to fly or fly during the whole trial. The approach I took seemed reasonable because 

soapberry bugs are particularly strong flyers, capable of reaching 14 km of flight distance and 

20+ h of continuous flight duration. This sort of stamina is important to capture as well as the 

frequency of bursting flight within a sample population. However, I do loose some information 

because of that, such as flight periodicity, because I removed continuous flyers as soon as they 

stopped flying. So, experimentally it is a trade-off between capturing the full flight capacity of 

insects and observing flight behavior or strategies. That being said, I now elucidate on this trade-

off/alternative experimental setup in the representative results. 

 

4. Please describe all parts and makes. For example, I couldn’t find the details for the IR sensor 

and data logger components. 

 

I added new details in steps 1.5.1. and 1.5.2. describing relevant features of the IR sensors and 

datalogger, respectively.   
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